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1 DL1 PRO Introduction 

 

 

 

 

1.1 What is the DL1 PRO? 

The DL1 PRO offers the same features as the DL1 MK3 but is encased in a water 

resistant enclosure with high specification water resistant connectors and an aluminium 

enclosure for more demanding environments. 

  

1.2 Who is the DL1 PRO designed for? 

The DL1 PRO is designed for autosport applications including drag racers, single seater 

racing cars, rally cars or road cars - however it is also ideal for use on power boats, go 

karts and motorbikes. It is also an ideal platform for use in the auto industry for car 

testing of all types, from long term monitoring to competitor benchmarking.  

 

1.3 What does the DL1 PRO do? 

The DL1 PRO can store data from a number of sources including its built in high 

accuracy GPS and accelerometers, wheel speeds, shaft speeds, engine speeds, 

temperatures, pressures, lap times, sector times etc. The DL1 comes packaged with the 

excellent Race Technology data analysis package for Windows. The software allows 

super accurate track mapping, user defined channels, powerful graphing and allows 

direct comparison of up to 10 data sets (races) simultaneously with almost unlimited 

laps. The DL1 PRO can also be used to supply data to dashboard displays and to drive 

auxiliary outputs to control fans, pumps, or lights. 
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1.4 Why use GPS? 

One of the key features of the DL1 PRO is its built in high accuracy GPS system - this 

gives the DL1 advantages over other data loggers in 2 key areas - greatly improved 

track maps and far more accurate speed data.  

1.4.1 Track Mapping 

Conventional data loggers require a "closed circuit" to enable them to calculate the track 

map; the shape of the track is estimated from a combination of the lateral acceleration 

and speed. This works adequately in some situations but it becomes increasingly 

inaccurate for long tracks and impossible for open circuits, motorbikes or boats. In 

contrast, the GPS will produce high accuracy track maps in almost any situation.  

1.4.2 Speed Measurement 

While speed is probably the most important parameter that anyone wants to measure 

using the data logging system, it is also the most inaccurate in a "conventional" system. 

The normal way to measure speed is to simply attach a pickup to a wheel to detect how 

fast it is rotating - but the rolling circumference of a tyre changes by 4% just with wear 

and temperature. Even worse, the error increases significantly under race conditions 

where the tyre is under load - typically the tyre slips by up to 20% under hard braking 

going into a corner. Measuring speed using GPS is now common practice in high-end 

systems - under typical conditions speed error is well under 1%!  
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1.5 DL1 PRO Features 

The DL1 PRO is an all-new, 3rd generation, data logger system from Race Technology. 

It is a complete redesign of the DL1, retaining all the best features and improving and 

adding where possible. Some of the most noteworthy features include:  

 Robust enclosure  

The DL1 PRO is housed in an aluminium enclosure with rubber seals around all 

connectors and the card slot to provide an element of water protection to the 

electronics. All connections to the unit are through two large multi way connectors 

and a single GPS connection for easy removal from the vehicle  

 Built in GPS  

The new GPS unit is based on our own high accuracy GPS3 technology and calculates 

position and speed 5 times every second. This is easily the fastest, most accurate GPS 

system available for under $1500. The measurements from the GPS and 

accelerometers are combined to calculate very high accuracy positions and speeds at 

100 times a second. Optional storage of raw GPS data for post processing at 20Hz is 

also possible.  

 Built in accelerometers  

Built in 3-axis accelerometer with 2g full scale (optional 6g full scale).  

 Built in yaw gyro for slip angle measurement (optional) 

  

 Logging to SD cards  

Works with SD and SDHC, for up to 32GB storage.  

 Up to 12 analogue inputs  

The DL1 PRO has 12 very high accuracy analogue inputs. All inputs have a maximum 

of 25V input  

 Up to 4 output drivers  

Low side driver outputs are available for controlling pumps, fans, lights.  

 2 RPM inputs  

The DL1 PRO has 2 RPM inputs, only one of which can be used at any one time. One 

input is designed to be connected to "high level" sources, such as the ignition coil. The 

other input is designed for low level signals such as a feed from the ECU.  

 4 wheel/shaft speed inputs  

The DL1 features 4 totally independent wheel/shaft speed inputs. These can be used to 

measure the speed of all four wheels, or slip ratios across a torque converter for 

example.  
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 Two RS232 ports  

Either port can be used to receive data for logging; one port is always used for 

outputting data for storage to a VIDEO4 or to a DASH display.  

 CAN port  

CAN port enable receiving and transmitting of messages at configurable rates up to 

1Mbit/s  

 Remote start/stop and add marker inputs 

  

 Dual 5v reference outputs  

Two independent 5v outputs can be used to drive up to 500mA each for sensor 

outputs.  

 Simple operation  

A single button to start or stop logging, it's as simple as that! If the button is 

inaccessible from the driver‟s seat then a remote button and status indicator can be 

added if required.  

 Power supply requirements  

The power supply to the DL1 PRO data logger can be taken directly from the vehicles 

12v supply, or it can be powered from it's own battery if required. The power supply 

is smoothed and regulated within the DL1 PRO ensuring its performance is highly 

robust and stable.  

 USB interface  

USB connection for direct connection to a PC for configuration  

 Testing  

Very high reliability is ensured by calibrating, temperature testing and vibration 

testing each unit on an individual basis. Autosport applications make tremendous 

demands on electronic systems and we take great care to make sure our products are 

up to the task. All the connections to the units are vibration proof, high strength to 

ensure that connections do not fail at the critical time.  

 Powerful  

The DL1 PRO has the latest 150MHz processor for maximum expandability and 

functionality  
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2 Technical Specification 

 

Memory  SD memory card, can be SD or SDHC. Up to 32GB  

GPS  Outputs position, speed, position accuracy and speed accuracy at 5Hz 

with no interpolation. GPS tracking loops optimised for applications up 

to about 4g. tracking of all satellites in view. 20Hz raw data storage for 

post-processed operation  

GPS Antenna  Magnetic base, 3.3v active antenna with SMA connector.  

Analogue Inputs  12 external inputs, all 12 bit resolution and 0-25v. All inputs are 

protected and filtered.  

Frequency Inputs  4 external frequency inputs with a maximum input frequency >2kHz. 

Triggering voltage requires a low input of <1v and a high input of >4v 

and 15v maximum.  

Lap Marker Input  Triggering voltage requires a low input of <1v and a high input of >4v 

and 25v maximum.  

Start Sample Input  Triggering voltage requires a low input of <1v and a high input of >4v 

and 25v maximum  

Low level outputs  4 low side drivers, each capable of driving 500mA.  

Power Supply 

Requirements  

12v nominal input, minimum of 10v, maximum of 25v. Current 

consumption of about 180mA including GPS, dependant on SD card 

requirements.  

+5v Reference Out Maximum current draw 500mA x 2.  

Ignition In Signal 

(High Level)  

Designed to connect directly to negative terminal of ignition coil. Can 

also fire from fuel injectors and from CD ignition systems.  

Ignition In Signal 

(Low Level)  

Triggering voltage requires a low input of <1v and a high input of >4v 

and 15v maximum. Suitable for connection directly to most ECU tacho 

outputs. Maximum input frequency >300Hz.  

Case Construction  Custom aluminium housing with integral mounting holes.  

Connector Type  19 way and 24 way Binder connector  

Main Processor  150MHz TI Digital Signal Processor  

Serial Port 1  User configurable for messages. Transmission and reception of RT 

format messages at 115200 baud  

Serial Port 2  Used for reception of RT messages at a fixed baud rate of 115200  

CAN Port  Message reception and transmission up to 1MBit/s  

Computer 

communication  

USB port for reflashing and reading/writing configuration  
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Accelerometers  3 axis, precision digital output. Guaranteed 2g minimum full scale on 

both axes. Resolution of 0.005g. Optional 6g sensor available as a 

factory option.  

Gyroscope  Single axis yaw rate gyro with a maximum rate of 300 degrees / sec.  

Vibration  Factory tested at 25g, 50Hz sinusoid for 5 minutes (without compact 

flash card inserted).  

Temperature  Factory tested from -20oC to 70oC  

"WARNING": To avoid any possible damage to the car paintwork, please take 

care when mounting magnetic GPS antennas. In particular make sure that there 

are no dust or grit under the antenna. In some cases it maybe required to add 

additional protection to the paintwork prior to mounting the antenna to avoid 

damage.  
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3 Installing the unit  

3.1 Mounting 
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4 Quick Start Guide 

This short guide is intended as a quick introduction to enable you to install the DL1 

PRO in a vehicle and log your first set of data. It is certainly not intended as a full set up 

guide. There are three sections to the quick start guide: Installing the DL1 PRO into the 

vehicle, logging some sample data and looking at the data for the first time using the 

software.  

4.1 Installing the DL1 PRO in the vehicle 

4.1.1 Mounting the DL1 PRO in the vehicle 

The DL1 PRO should be mounted in the vehicle on a flat horizontal surface. For 

temporary installation you can just use the Dual-LockTM tape supplied, or for a more 

permanent installation the mounting brackets. The DL1 PRO must be mounted with the 

buttons and lights facing either directly towards the back or the front of the car. Avoid 

any extremes of temperature and vibration for both the DL1 PRO module and the GPS 

antenna. In particular, if the DL1 PRO is exposed to vibration then the GPS data will 

become inaccurate.  

4.1.2 Correct Mounting of the GPS Antenna 

"WARNING": To avoid any possible damage to the car paintwork, please take 

care when mounting magnetic GPS antennas. In particular make sure that there 

are no dust or grit under the antenna. In some cases it maybe required to add 

additional protection to the paintwork prior to mounting the antenna to avoid 

damage.  

For correct, accurate operation of the GPS receiver it is absolutely essential that the 

antenna is mounted correctly. There are several important aspects to consider when 

mounting the antenna:  

 The antenna must have a clear view of the sky in all directions. Note that it is NOT 

enough that the antenna can see vertically upwards towards the sky, it must also be 

able to see all the horizons as well. The GPS system actually gets very little positional 

or speed information from the satellites directly above, it gets far more information 

from satellites on or near the horizon. For example if the antenna was mounted in the 

bottom of a "bucket", so it could upwards but no horizons, then the GPS system would 

lock and provide positional information - but the accuracy would be very poor. In 

practice this all means that the antenna should be mounted on the highest point of the 

vehicle.  

 The antenna must be mounted on a horizontal surface. The antenna must be mounted 

on a horizontal orientation facing directly up. The underside of the antenna cannot 

receive GPS information, similarly don't mount the antenna on a vertical surface.  

 The antenna must not be covered in tape, in particular dark coloured tapes. Many tapes 

absorb the weak GPS radio signal. In general, black tapes are the worst in this respect 

as they contain high amounts of carbon - however, to be safe, avoid using any tape at 
all.  
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 The antenna must not be subjected to high levels of vibration. Although the antenna is 

physically robust to vibration, it can and does affect GPS reception, so isolate it as 
much as possible.  

 The antenna must be physically remote from sources of electrical noise. The GPS 

radio signal is very weak and can easily be blocked out by radio interference, so to get 

a good signal the antenna must be as far away from radio interference as possible. By 

far the strongest source of radio interference is a gasoline engine's ignition system, so 

keep the antenna away from all aspects of it including the engine management system, 

coil, leads, distributor etc.  

 Avoid trapping, pinching or kinking the antenna cable. The lead from the GPS antenna 

to the receiver is a special very high frequency cable and it is not normally practical to 

repair it - so if you do trap, pinch or cut it then the antenna will have to be replaced 

and this isn't covered by the warranty. Do not try to feed the antenna cable through a 

closure gap that is too small or compress it with a door seal or window seal.  

 If at all possible, mount the antenna on a metal platform. The GPS radio signal is 

amplified if the antenna is mounted on a metal plate (termed a ground plane), and the 

bigger this plate is the better it will be for GPS reception. This is not essential for 
correct operation, but it is desirable.  

 Allow time for the GPS system to lock on before sampling data. The GPS receiver 

typically takes one to two minutes to lock on to all the available satellites. The time to 

lock onto satellites varies significantly with conditions but is minimised when the 

vehicle is stationary.  

4.1.3 Recommended mounting positions for the GPS antenna 

 If the vehicle has a roof, this is the ideal place to mount the antenna.  

 Alternatively, the best mounting position on a car may be the roll over bar or the top 

of the windscreen frame.  

 On a motorbike, mounting is a little more difficult, but the best compromise is on a 
flat area of the tail unit, behind the rider.  

 Poor mounting positions on a car include behind the front or rear windscreens.  

Note: If you fail to adhere to the guidelines above, the GPS will still probably perform 

"adequately" "most" of the time, however when conditions are more challenging (with 

tree cover or bad weather etc) the positional accuracy will be significantly reduced.  

4.1.4 Connecting the GPS module (if used) 

Place the GPS antenna on the roof of the car, and screw the antenna connector onto the 

gold connector on the back of the DL1 PRO.  

4.1.5 Connecting the power cable 

If there is a cigarette lighter socket available on the vehicle, then the power lead 

provided can be used as a simple convenient way to supply power to the DL1 PRO. If 

not, connect the DL1 PRO to a fused power source, which is available when the ignition 

is turned on. Connecting to a permanent power source will cause the DL1 PRO to drain 

the battery continuously. Please do not connect anything to your car unless you are 

confident in what you are doing!  
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4.2 Default Configuration 

The DL1 MK3 can be configured by direct connection to a PC through the USB port or 

by loading the configuration file on to the SD card which is put in to the unit. The unit 

has a default configuration from the factory. This configuration has the following 

settings for the analogue channels:  

1. Spare input  

2. Fuel level  

3. Boost pressure  

4. Air temperature  

5. Oil pressure  

6. Oil temp  

7. Water temp  

8. Start / stop control  

 

 If the output driver option is enabled, the port 12 is used as the status output.  

 Frequency inputs are set to map to wheel speeds 1-4, the high level RPM input is 
enabled.  

 All channels are transmitted on the serial port and all channels are logged to the SD 

card.  

 Automatic starting and stopping of logging are disabled.  

If you need to change any of these configurations, start up the DL1 MK3 configuration 

software.  

Full instruction on how to configure the unit can be found in the online help which is 

installed with the Analysis software package.  

NOTE: The default configuration will need to be changed if the unit is used with an 

ECU interface, failure to change this will result in no readings for any of the channels 

listed above.  
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4.3 Logging data using the DL1 PRO 

4.3.1 Powering up the DL1 PRO 

Start the vehicle, wait a few seconds the "Power" LED will come on. Wait for a few 

moments while the GPS receiver acquires a good positional lock. Once the GPS has a 

lock, the GPS LED on the front of the DL1 PRO will light up.  

4.3.2 Insert an SD card 

Take an SD or SDHC card and format it in the PC – the card must be formatted as 

“FAT32” formatting it as “NTFS” or any other file system will cause unexpected 

behaviour. When formatting is complete, remove the card and place it in the DL1 PRO 

slot. Once it is inserted wait a few seconds and the status light should start flashing 

indicating that the DL1 PRO is ready to start logging data. If the status light does not 

start flashing, power down the DL1 PRO and repeat the above steps. If the status light 

does not flash on / off in equal measure then it could be one of the following problems:  

9. SD Card detection error - one quick flash and off period  

10. FAT file system initialize error – two quick flash and off period  

11. SD card write error – three quick flash and off period  

12. SD card read error – four quick flash and off period  

4.3.3 Sampling data 

To sample some data, simply press the "Start/stop logging” button on the front of the 

DL1 PRO. After a short pause, the "Logging" LED will illuminate, indicating that data 

is being stored on the memory card. Drive the vehicle around for a while (slowly, safely 

and in a responsible manner). To stop sampling press the "Start/stop logging" button 

again. When you have stopped sampling data you can turn off power to the DL1 PRO 

unit. Never remove the card from the DL1 PRO whilst it is logging data. This can 

corrupt the card and the data will be lost.  
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4.4 Analysing data from the DL1 PRO 

Please note that the analysis software supplied with the DL1 PRO is very powerful and 

flexible and in most cases there are several ways that the same information can be 

accessed or generated. This guide is intended to be a very brief introduction to the 

software to enable you to get up and running as quickly as possible. When you require 

more information, or find a problem carrying out any of the following procedures, 

please refer to the on line help system that comes supplied with the DL1 PRO.  

4.4.1 Installing the SD card reader 

If required, install the SD card reader according to the manufacturers instructions. On 

many laptop computers the card reader is already built in and the external reader is not 

required.  

4.4.2 Installing the software on the PC 

Before you can analyse the data from the DL1 PRO you must install the software from 

the supplied CD onto your PC. When you insert the CD-ROM, the installation program 

should start automatically. Follow the onscreen instructions to install the software.  

4.4.3 Loading the data into the software 

To load the data from the SD card, remove the card from the slot in the front of the DL1 

PRO (after stopping logging) and place it in the card reader connected to your PC. The 

data files on the SD card will appear in Windows Explorer as “.run” files separated into 

directories named with the date on which they were recorded. Your test data file can 

either be opened by "double clicking" on a “.run” file, or alternatively you can start the 

software and go to "File” -> “Open". The data will now download – once it has done so, 

click “yes” when you are asked if you want to process the data.  

4.4.4 Display the track map and a graph of speed for the entire run 

To view a map of the current data that is loaded select the “Results” -> “Track map” 

menu, use the zoom button to navigate around the map. To display a simple graph of 

speed for the entire run, select the “Results” -> “Graph” menu, and under the “Setup” 

tab select “GPS Speed [mph]” as the first variable. Then click back on the “Graph” tab 

to view the data.  

4.4.5 Display your acceleration and braking times. 

To display a full table of the acceleration times go to the “Results” -> “Performance 

Calculations” menu and then select the “Timings” tab. A table of acceleration times 

extracted from the data will be generated automatically.  

4.4.6 Displaying lap and sector times 

The first stage of the process is to add a “lap marker” to the track map. This is done in 

the “track map” window by selecting the “add track marker” tool from the top right 

hand corner of the track map window and adding a marker across a section of the track. 
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Next, go to the “Window” -> “Show Lap/Sector times” menu and you will be presented 

with a list of lap times in a spreadsheet style table. You can add and name sectors 

manually on the track map, but for this example we will add the markers automatically. 

To do this go to the “Data” -> “Laps and Sectors” menu, select the “Sector setup” tab 

and then click the “Automatically add sectors now” button. After a short pause, the 

sectors will be shown in the table. Close the “Lap and Sector options” dialog box. If you 

look at the track map you will see that a number of track markers and named sectors 

have been added, also if you check the “Lap and Sector Times” table, you will see that 

sector times are now displayed alongside the lap times.  

4.4.7 Automatically generating a graph comparing speeds on two laps 

You can automatically generate a graph showing the speeds for 2 laps most easily from 

the “Lap and Sector times” table. Simply select the lap times of interest on the “Lap and 

Sector times” table, as they are selected the cells will turn red. After selecting the laps of 

interest, click the “graph” button at the top left hand side of the table. You will be 

prompted for the type of graph you wish to generate, select “Speed versus Distance” 

and click “Ok”. After a short pause a graph will appear with speed information for the 

laps selected.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



17 
Race Technology Ltd. VAT reg. 715 9671 09 

After 12, King Street, Eastwood, Nottingham, NG16 3DA, UK 

Tel: +44 (0) 1773 537620 Fax: +44 (0) 1773 537621 

Email: sales@race-technology.com 

5 Operating the DL1 PRO 

5.1 Description of the plug/connections/lights etc on the DL1 

PRO 

 

 

 

 

 

 

 

 

 

 

 

 

F 

R 

O 

N 

T 

Start/Stop 

Logging 

Button  

 

Press once to start logging, again to stop logging.  

 

 

 

 

 

Status Light  

This light flashes to indicate that the DL1 PRO‟s processor is 

operating normally and is ready to log data.  

 

In an error situation, it blinks with specific patterns. Different 

error states and there blinking patterns are describe in below. 

  

13. SD Card detection error - one quick flash and off 

period  

14. FAT file system initialize error - two quick flash and 

off period  

15. SD card write error - three quick flash and off period  

16. SD card read error - four quick flash and off period 

  

 

GPS Lock 

Light  

This light will be on when the GPS receiver has a lock. Please 

see the following page for details about mounting the GPS 

antenna are: 

 

http://www.race-

technology.com/wiki/index.php/Common/MountingAGPSAntenn

a  

 

 

Power On  

This light illuminates when the DL1 PRO is connected to a valid 

power supply. Advice about connecting a power supply is on 

following page: 

 

http://www.race-

technology.com/wiki/index.php/Common/PowerSupplyRequirem

ents 

Logging  This light illuminates when the DL1 PRO is actually logging 

data to the SD card. When this light is illuminated YOU MUST 

NOT TURN THE DL1 PRO OFF, OR EJECT THE SD CARD! 

  

SD card Slot  This is the slot for the SD or SDHC card.  
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A1  Analogue input 1, for use with external sensors maximum input 25v.  

A2  Analogue input 2, for use with external sensors maximum input 25v.  

A3  Analogue input 3, for use with external sensors maximum input 25v.  

A4  Analogue input 4, for use with external sensors maximum input 25v.  

A5  Analogue input 5, for use with external sensors maximum input 25v.  

A6  Analogue input 6, for use with external sensors maximum input 25v.  

A7  Analogue input 7, for use with external sensors maximum input 25v.  

A8  Analogue input 8, for use with external sensors maximum input 25v.  

A9  Analogue input 9, for use with external sensors maximum input 25v. 

Low side driver output, maximum 0.5A  

A10  Analogue input 10, for use with external sensors maximum input 

25v. Low side driver output, maximum 0.5A  

A11  Analogue input 11, for use with external sensors maximum input 

25v. Low side driver output, maximum 0.5A  

A12  Analogue input 12, for use with external sensors maximum input 

25v. Low side driver output, maximum 0.5A  

GND  Ground, recommended for grounding analogue sensors.  

Ground  Ground, recommended for grounding analogue sensors.  

+5v1  +5v output, maximum current output 1A. This can be used for 

powering external sensors.  

+5v2  +5v output, maximum current output 1A. This can be used for 

powering external sensors.  

+12v 

Power  

ESSENTIAL! This is the power supply for the DL1 PRO, it needs 

10v-15v and about 150mA minimum. For More details read 

http://www.race-

technology.com/wiki/index.php/Common/PowerSupplyRequirements 

GND  ESSENTIAL! This is the ground for the power supply to the DL1 

PRO. Details are in the following page: 

http://www.race-

technology.com/wiki/index.php/Common/PowerSupplyRequirements  

rL  This is the "low level" rpm input that triggers about 5v - this MUST 

NOT be connected to the ignition coil. Details here: 

http://www.race-

technology.com/wiki/index.php/Common/ConnectingRPMSensors 



19 
Race Technology Ltd. VAT reg. 715 9671 09 

After 12, King Street, Eastwood, Nottingham, NG16 3DA, UK 

Tel: +44 (0) 1773 537620 Fax: +44 (0) 1773 537621 

Email: sales@race-technology.com 

 

 

 

 

 

 

 

R 

E 

A 

R 

rH  This is the "high level" rpm input that connects to the low voltage 

side of the coil. Details here: 

http://www.race-

technology.com/wiki/index.php/Common/ConnectingRPMSensors 

rG  This is the ground for the "high level" rpm input that connects to an 

HT lead or the low voltage side of the coil. Details here: 

http://www.race-

technology.com/wiki/index.php/Common/ConnectingRPMSensors 

F1  Frequency input 1, for connection to an external shaft or wheel 

speed. Triggers at 3v. Details here: 

http://www.race-

technology.com/wiki/index.php/Common/AddingWheelSpeedSensors 

F2  Frequency input 2, for connection to an external shaft or wheel 

speed. Triggers at 3v. Details here: 

http://www.race-

technology.com/wiki/index.php/Common/AddingWheelSpeedSensors 

F3  Frequency input 3, for connection to an external shaft or wheel 

speed. Triggers at 3v. Details here: 

http://www.race-

technology.com/wiki/index.php/Common/AddingWheelSpeedSensors  

F4  Frequency input 4, for connection to an external shaft or wheel 

speed. Triggers at 3v. Details here. 

http://www.race-

technology.com/wiki/index.php/Common/AddingWheelSpeedSensors  

GPS 

RF 

+3.3v  

GPS antenna connection (gold SMA type). This feeds 3.3v out to the 

active GPS antenna and takes in the GPS rf signal.  

Data 

Port  

This single connector actually connects to 2 serial ports and a CAN 

port. One of the serial ports is generally used to connect to a display 

unit, such as a DASH2, the other to an ECU interface.  

"WARNING": To avoid any possible damage to the car paintwork, please take 

care when mounting magnetic GPS antennas. In particular make sure that there is 

no dust or grit under the antenna. In some cases it maybe required to add 

additional protection to the paintwork prior to mounting the antenna to avoid 

damage.  
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5.2 Sampling Data with the DL1 PRO 

 If used, connect a GPS antenna to the rear of the DL1 PRO.  

 Connect the DL1 PRO to a valid power supply. After a short pause the power light on 
the front of the unit will come on and the status light will start flashing rapidly.  

 Insert a freshly formatted SD card into the slot, the status light will stop flashing for a 

second or 2 then start again when the DL1 PRO is ready to log data.  

 Press the "Start/Stop Logging" button on the front of the DL1 PRO, the "Logging" 
light will come on indicating that the DL1 PRO is writing data to the SD card.  

5.2.1 To stop data logging: 

 Press the Start/Stop Logging button on the front of the DL1 PRO; the "Logging" light 

will go out.  

 ONCE THE LOGGING LIGHT HAS GONE OUT, eject the SD card from it's slot. 
Power can now be disconnected if required.  

 Put the SD card in a suitable reader and check a file has been written to it.  

5.2.2 Advanced operation 

You can set the DL1 PRO to automatically start and stop logging based on external 

inputs or on a timed basis. For more information on how to do this, read the following 

section on the web: 

http://www.race-technology.com/wiki/index.php/Configuration/DL1MK3Configuration 

5.3 Real Time Output 

Practically the whole time the DL1 PRO is powered up, it is outputting data in real time 

to the external serial port. This can be used for a number of applications including 

monitoring the data on a PC or streaming to a dashboard or video logger.  

5.4 Further Reading 

For more information on operating the unit, please Read the following pages on the 

Race Technology knowledgebase: 

 http://www.race-

technology.com/wiki/index.php/HowDoI/ManuallyCommenceLoggingOnDL1MK3 

 http://www.race-

technology.com/wiki/index.php/DL1MK3Configuration/AutomaticLoggingControl 
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6 Connecting external sensors to the DL1 PRO 

6.1 Connecting GPS 

For the DL1 PRO, the GPS antenna comes with 3 metre cable, which will allow you to 

position the module almost anywhere on a road car. The GPS antenna connects via a co-

axial screw connector on the back of the DL1 PRO Unit. Once the GPS antenna has 

been connected, it will turn on automatically when there is power to the DL1 PRO unit.  

The best place to position the GPS antenna will change depending on the vehicle type. 

The GPS needs a good clear view of the sky to be able to lock onto the satellites to give 

the best results. As such, if there is a roof to the vehicle, this will always be the best 

place to place the antenna. If you are on a vehicle like a kart or a bike, then you will 

have to find the best location which gives a constant view of the sky.  

For more detailed information on GPS antenna positioning, read the following page: 

http://www.race-technology.com/wiki/index.php/Common/MountingAGPSAntenna 

Please note that if your GPS antenna gets damaged, you can buy a replacement antenna 

from Race Technology. Email sales@Race-Technology.com for further details if you 

need a replacement antenna.  

"WARNING": To avoid any possible damage to the car paintwork, please take 

care when mounting magnetic GPS antennas. In particular make sure that there is 

no dust or grit under the antenna. In some cases it maybe required to add 

additional protection to the paintwork prior to mounting the antenna to avoid 

damage.  

 

6.2 External Sensors  

The DL1 PRO allows you to attach several external sensors for logging. These can be 

frequency or analogue inputs. There are 4 frequency inputs, generally used for shaft or 

wheel speeds, and 12 analogue channels (25v input). The DL1 PRO is supplied with 

connectors for the external inputs. For each input, the positive wire connects to the 

input, and the ground to one of the ground connectors. If the sensor needs a 5v reference 

supply, there are two available on the back of the unit. You can have more than one 

sensor attached to the ground and reference output.  

If you wish to connect an RPM sensor, see the following page for more details: 

http://www.race-technology.com/wiki/index.php/Common/ConnectingRPMSensors  

The 25v input is a nominal maximums, exceeding this upper voltage limit will cause 

other channels to read incorrect voltages.  
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6.3 Connecting A wheel speed sensor 

Allow a few hours to mount and test the wheel speed sensor correctly, there is no 

simple/universal solution to fitting the wheel speed pickup and in some applications it 

can be problematic. The wheel speed sensor supplied by Race Technology is a high 

quality "Hall Effect" type, it is the same type of sensor that is used in high quality ABS 

and traction control systems on high performance production cars. This type of sensor 

does not require a magnet to trigger it, just something metal - typically, the sensor is 

mounted so it is pointing at a moving bolt head. The sensor should be rigidly mounted 

using the bolt hole though the sensor and with the end less than 3mm from the moving 

metal object. The closer to the metal object the sensor is mounted, the better the slow 

speed performance of the sensor. There are 3 wires connected to the wheel speed 

sensor: More information on the following page: 

http://www.race-technology.com/wiki/index.php/Common/AddingWheelSpeedSensors 

 The black wire that should be connected to the ground terminal of the DL1 PRO  

 The red wire that should be connected to the +5v output of the DL1 PRO  

 The white wire that should be connected to the wheel speed input (one of the 

frequency inputs) of the DL1 PRO 

 

  

6.4 Remote start/logging indicator 

The DL1 PRO has the option to have an external start/stop logging switch and an 

external indicator fitted. There are no dedicated pins on the DL1 PRO to do this. It is 

done by using one of the analogue inputs as the logging control input and one of the low 

side driver outputs (Analogue 9-12) as the logging status output.  

 Connect a momentary switch between Analogue input 11 and one of the 5v 

references. This will put a 5v pulse on the analogue input which will trigger 

the start/stop.  

 Connect the - terminal of an indicator lamp / LED to Analogue input 12 and 

the + terminal to either one of the reference outputs or to the main 12v supply.  

This means that not only can you start and stop the logging remotely, you can also 

monitor whether the device is currently logging - useful when the DL1 PRO unit is 

mounted in a position that cannot be seen from the drivers seat.  
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7 Connections 
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7.1 DL1 PRO 24 Way Cable 
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24 

way  

Name  Description  Connector or wire colour  

1  ADC7  0-25v 12 bit analogue input  white  

2  ADC5  0-25v 12 bit analogue input  black  

3  ADC10 Out2  0-25v input, low side output 0.5A  red-black  

4  ADC 9 Out1  0-25v input, low side output 0.5A  gray  

5  ADC6  0-25v 12 bit analogue input  blue  

6  ADC8  0-25v 12 bit analogue input  green  

7  12v  12v supply for serial peripherals  RS232-1-2 d-type plug pin 7  

8  5v ref 2  0.5A reference output  brown  

9  ADC12 Out4  0-25v input, low side output 0.5A  red  

10  ADC11 Out3  0-25v input, low side output 0.5A  orange  

11  GND  USB GND  USB connector  

12  USB5V  USB 5v  USB connector  

13  USB D-  USB Data -  USB connector  

14  CAN1 L  CAN port 1 low  CAN[1] d-type plug pin 2  

15  GND  Serial port 1 GND  RS232[1] d-type plug pin 5  

16  GND  Serial port 2 GND  RS232[2] d-type plug pin 5  

17  RS232 2 in  RS232 port 2 RX  RS232[2] d-type plug pin 2  

18  RS232 1 out  RS232 port 1 TX  RS232[1] d-type plug pin 3  

19  CAN2 L  CAN port 2 low  CAN[2] d-type plug pin 2  

20  CAN1 H  CAN port 1 high  CAN[1] d-type plug pin 7  

21  USB D+  USB Data +  USB Connector  

22  CAN 2 H  CAN port 2 high  CAN[2] d-type plug pin 7  

23  RS232 1 in  RS232 port 1 Rx  RS232[1] d-type plug pin 2  

24  RS232 2 out  RS232 port 2 Tx  RS232[2] d-type plug pin 3  
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7.2 DL1 PRO 19 Way Cable 
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way  

Name  Description  Connector or wire colour  

A  ADC1  0-25v 12 bit analogue input  black  

B  ADC2  0-25v 12 bit analogue input  brown-black  

C  GND  Sensor ground  red-black  

D  12v  System power 9-24v  figure-8 cable black-white  

E  GND  Power ground  figure-8 cable black  

F  High level RPM  1kHz HT input  orange-black  

G  RPM_GND  See Connecting RPM  yellow-black  

H  GPS LED  Active low GPS LED driver (20mA  green-black  

I  5v ref 1  0.5A Reference output  blue-black  

K  Frequency in 3  5-12v input >2khz max (100k 

pulldown)  

grey-black  

L  Frequency in 4  5-12v input >2khz max (100k 

pullldown)  

white-black  

M  ADC4  0-25v 12 bit analogue input  brown  

N  ADC3  0-25v 12 bit analogue input  red  

O  Power LED  Active low Power LED driver 

(20mA)  

orange  

P  Low level RPM  5-15v Trigger - ECU or Tacho use  yellow  

R  Logging LED  Active low Logging LED driver 

(20mA)  

Green  

S  Status LED  Active low Status LED driver 

(20mA)  

blue  

T  Frequency in 1  5-12v input >2khz max (100k 

pullldown)  

gray  

U  Frequency in 2  5-12v input >2khz max (100k 

pullldown)  

white  
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8 Live Speed option 

The DL1PRO and DL1WP models are available with optional output of live speed. This 

option takes the data from the GPS system and the built in accelerometers and combines 

them using a kalman filter to provide a real time output of speed with is updated at up to 

100Hz and which is resistant to brief GPS outages such as bridges or buildings.  

To use the option, the DL1 is installed in the standard way, paying particular attention 

to align and level the unit correctly in the car, and with the GPS antenna on the car roof.  

The output rate of the live speed output is set in the serial output, the logging rate, and 

the CAN output rate as needed.  

Typical applications are general speed testing, a traction control signal for an ECU or a 

live speed signal to other instrumentation in the vehicle. If higher accuracy is required, 

then please refer to the SPEEDBOX product.  
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8.1 Live speed accuracy 

To validate the accuracy of the DL1s live speed output it was installed in a road car 

along side a production SPEEDBOX unit which was used as a reference. The speeds 

measured by both units were compared for 2 hours of driving in a mixture of rural and 

urban conditions. The distribution of errors are shown below, for this extended test the 

standard deviation of the errors was 0.21m/s. Based on this it would be expected that for 

a test track conditions the error would be significantly lower, and for very built up urban 

errors, or testing with significant GPS outages (e.g. tunnels) the results would be worse.  
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9 How Do I? 

9.1 How do I manually start and stop logging on my DL1 PRO? 

When the DL1 PRO is not logging, the “logging” LED will not be illuminated. Make 

sure that the status LED is flashing, this indicates that the unit has a valid memory card 

inserted and is ready to start logging. If the LED is not lit, check that the memory card 

is not full and is correctly formatted.  

Press the Start/Stop Logging button. The Logging LED will illuminate and logging will 

start. To stop the logging, press the button again.  

 

 
 

 

9.2 How do I connect a start/stop switch with indicator? 

To connect a start/stop switch, wire as shown in the diagram below:  

 

The "start/stop" button gives the driver the option of starting/stopping logging on the 

DL1 without having to press the button on the unit itself. Unlike the sensors that may be 

connected to the DL1, the start/stop button has three connecting wires, and needs to be 

connected differently.  
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Step 1: 

Connect the wires on the start/stop button to the black, block connector that is on the 

end of the DL1 power cable. Once the block connector is plugged into the back of the 

DL1, the orange writing on the unit will tell you where to put the wires:  

 Red should be connected to 12v  

 Blue should be connected to A8  

 Yellow should be connected to A12  

 

Step 2: 

The DL1 will need to be configured to use Analogue 8 as the trigger input, and to use 

Analogue 12 as the status output. For instructions on how to do that see here: 

  Configuring inputs on the DL1 PRO 

http://www.race-technology.com/wiki/index.php/DL1MK3Configuration/AnalogueInputs 

 Configuring output drivers on the DL1 PRO 

http://www.race-technology.com/wiki/index.php/DL1MK3Configuration/OutputDrivers 

Once the button is properly connected, test that it is working. A red LED should light up 

in the buttons' centre to show when the unit is logging.  

 

9.3 How do I connect a logging indicator? 

To connect a logging indicator, wire up as shown in the diagram below:  

 

As well as wiring up the LED, the DL1 will need to be configured to use one of the low 

side driver outputs as a status output. See the following page for more information: 

http://www.race-technology.com/wiki/index.php/DL1MK3Configuration/OutputDrivers 
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9.4 How do I connect a 1 or 2 wire sensor to the DL1 PRO 

The DL1 PRO requires a voltage input on it's sensor inputs that goes from a minimum 

of 0v to 12v maximum.  

For sensors with 3 wires, typically you have:  

 voltage supply  

 0v or ground  

 signal out  

Note that in some cases the ground connection maybe via the body of the sensor in 

which case there will only be 2 wires coming out of the actual sensor - however this is 

relatively unusual.  

In this case the signal out can be connected directly to the one of the analogue inputs on 

the DL1 PRO.  

For sensors with 1 or 2 wires, it is slightly more complicated.  

For a sensor with 2 wires it is typically a variable resistor with both ends of the resistor 

available:  

 

In this case we need to use a "pull up" resistor to convert the changing resistance to a 

changing voltage:  

 

1 wire sensors are the same, but in this case the 2nd wire on the sensor is ground and 

made via the sensor body earthing to the engine casting etc.  
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Once the sensor is connected to the DL1 PRO with the pull up resistor then it can be 

calibrated in the normal way. For more information on this, please refer to this section. 

http://www.race-technology.com/wiki/index.php/HowDoI/ConnectMyOwnSensor 

  

9.4.1 Choosing a value for the pull up resistor 

Please note that it is the installer responsibility to choose the correct value of “pull up” 

resistor when using 1 or 2 wire sensors with Race Technology products. For a particular 

sensor type there is no “correct” value of resistor however it must be selected to be 

“somewhere near” to ensure:  

 There is a reasonable voltage swing, ideally this wants to be a “few volts” 

rather than a few “milli volts”. A small signal can get easily lost in “noise”.  

You cannot take to much current from the 5v reference output, depending on the 

product typically this cannot be more than a total of 100mA.  

The table below gives a indication of suitable pull up resistor values:  

Sensor  Pull up resistor  Notes  

100 ohms or lower (typical 

for low cost/quality VDO 

sensors)  

100 ohms  With such a low pull up resistor 

you will only be able to have a 

maximum of 2 sensors before 

you use 100mA  

Between about 100 ohms 

to 500 ohms  

Between about 100 ohms 

to 500 ohms 500 ohms  

   

Between about 500 ohms 

to “a few” kilohms  

1 kilohm (1k)  This is the normal setup for Race 

Technology Supplied sensors  

Between “a few” kilohms 

and “a few” 10‟s kilohms  

10 kilohm (10k)     
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9.5 How do I read data from my ECU and display it on my 

DASH1/DASH2 or log it on my DL1/DL2? 

To do this, you will require a Race Technology ECU interface.  

Over recent months we have developed a wide range of ECU interfaces, that are 

compatible with various models of ECU used in the modern, automotive industry.  

Some of our interface units are currently going through Beta testing, whist others are in 

the development stage.  

Please do not hesitate to contact the Race Technology sales department to check the 

availability of our units for the make and model of your ECU.  

You can contact us on:  

+44 (0)1773 537620  

or email us at:  

sales@race-technology.com  
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9.6 Log DASH2 Analog Inputs 

This section explains how to configure the DL1 PRO to receive DASH2 analogue 

channels  

1. Configuring the DL1 PRO to expect the messages on the serial port  

 Open the DL1 PRO configuration software  

 If you already have a configuration for the DL1, load in the relevant 

configuration.  

 Click on the „Variable Mapping‟ tab.  

 Set Analog 17-20 to be from Serial Port 1 Only: 

  

 

If you wish to take RPM data from the DASH2, scroll up and set the RPM to also come 

from the same serial port. If the option is greyed out for taking RPM data from the serial 

you will first need to disable the internal RPM sensor on the DL1 PRO.  

 

2. Set the storage rate for the data on the Flash Card Storage tab.  
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3. Save the configuration file and transfer it to the DL1 PRO.  
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9.7 Why won’t my DL1 PRO work? 

There may be a number of reasons why the DL1 PRO will not start logging. You should 

check for the following things:  

 Is your SD card full?  

 Is your SD card correctly formatted? (It must be FAT, FAT32 or FAT16, and 

NOT NTFS)  

 Is the Status LED flashing on the front of the unit  

 Is the unit configured to automatically start/stop logging?  

 Has your SD card been dropped/damaged/exposed to high temperatures?  

These are the most common faults. If you have eliminated these, and your DL1 PRO 

will still not log, please visit the support page on the website for further advice:  

http://www.race-technology.com  

 

9.8 Connect an RPM input 

The high level RPM input on the DL1 PRO can be used to connect to the negative 

terminal of an ignition coil. The Red wire must connect to the rH terminal, and the 

black wire to the rL terminal.  

To configure the DL1 PRO for the RPM input, start the configuration software and go 

to the RPM inputs tab.  

 
 

 Enable the High RPM input, set the number of pulses per revolution, depending on the 

ignition system you are using. If you are having issues with noise on the signal you 

can also set filtering for smoothing and maximum rate of change here.  

 Click on the Flash Card Storage tab and set the speed at which the RPM input will be 
logged to the memory card. 
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 If you are using the serial output of the DL1 PRO to drive a dashboard or other 
display, also set up the output rate for the Output Serial Data tab in the same way.  

 Save the configuration file and load it on to the DL1 PRO.  
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9.9 How do I find out why my logger stopped logging during a 

race? 

Step 1: Load up the data that was logged into the analysis software, and enter the "Run 

Manager" feature in the data menu (this can be found in the top, left hand corner of the 

screen).  

 

 

Step 2: this will open up a window. At the bottom of the window, under the heading "Run 

Details", you will find a breakdown of the details of the run. The reason why the unit stopped 

logging data will be stated at the end of this breakdown. In this example, the stop logging 

button was pressed.  
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10 Frequently Asked Questions 

10.1 What is the difference between the DL1 PRO and the DL1 

MK1/2? 

The DL1 PRO is a complete redesign of the DL1. It uses the same GPS receiver, 

accelerometer, and gyro, but pretty much everything else has been changed. It now 

operates with SD card instead of Compact Flash, it has a much more powerful 

processor, more analogue inputs, output drivers, dual serial ports. 

Specification  DL1 MK2  DL1 PRO  

GPS  5Hz, 20Hz optional  5Hz, 20Hz optional  

Analogue inputs  8  12*  

Frequency inputs  4  4  

Accelerometers  3 axis  3 axis  

Serial ports  1  2  

CAN ports  0  1  

USB ports  0  1  

6G accelerometer 

option  

yes  yes  

Input voltage  10-15v  9-24v  

Reference output  5v 50mA  5v 500mA x 2  

Output drivers  0  0.5A low side driver x 4 *  

Memory card  Compact Flash, up to 1GB  SD or SDHC, up to 32GB  

Enclosure  Extruded aluminium with 

carbon fibre front and back 

panels  

Injection moulded ABS with 

polycarbonate front and back 

panels  

Auto start / stop  Limited to analogue inputs 

and speed  

Can use any channels of data  

RPM input  High and low level inputs  High and low level inputs  

Gyroscope  Optional  Optional  

* Some features share pins on the connector, so not all can be used at the same time.  

* Not all features are standard  
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10.2 What is the maximum g-force/speed that can be 

measured? 

The standard DL1 is configured for a maximum of 2g acceleration, 6g is a factory 

option. The maximum measurable speed is about 1000mph.  

10.3 How often do you get GPS speed updates? 

The GPS system calculates speed every 200ms (5 Hz), however this data is combined 

with the data from the accelerometers to calculate speed 100 times every second with 

very high accuracy.  

10.4 How often do you get GPS position updates? 

The GPS system calculates position every 200ms (5 Hz), however this data is combined 

with the data from the accelerometers to calculate position 100 times every second with 

very high accuracy.  

10.5 How accurately is speed measured? 

With average GPS reception, speed accuracy is about 0.1mph (or 0.1% if greater) when 

you are just driving along at fairly constant speed, and about 0.2mph (or 0.1% if 

greater) during fast accelerations or braking. The only exception is at very low speeds 

(under 10mph) where the error increases to about 1mph. Do not be fooled by 

exaggerated claims from other manufacturers… this is as good as it gets! In contrast, a 

standard wheel speed pickup is only accurate to about 4% at constant speeds, and under 

high accelerations or braking, the error increases up to about 20%.  

10.6 How accurately is position measured? 

With good GPS reception, positional accuracy is about 3m (CEP).  

10.7 What happens to the data if you drive under a 

bridge/tunnel/trees etc? 

Because speed and position are calculated from both the GPS data and accelerometers, 

even if the GPS data “disappears” for a number of seconds, you won‟t be able to tell 

from the data in the software. Only if GPS data disappears for an extended time (20+ 

seconds) will the data start to degrade noticeably.  

10.8 Where can I buy it? 

Check the following page for an up-to-date list of stockists:  

http://www.race-technology.com 
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10.9 Is it upgradeable? 

The DL1 PRO is upgradeable in a number of ways; please check the following page on 

the web for an up-to-date list of options. Software and firmware updates, including new 

features, are freely available as we introduce them.  

http://www.race-technology.com 

10.10 How much data can you log to an SD card? 

The DL1 logs about 25MB of data per hour, so for a 8GB card you could get up to 

about 2 weeks of data  

10.11 Will it work with any SD card? 

Whilst we cannot guarantee that the DL1 PRO works with all SD and SDHC cards, we 

have successfully tested many makes and sizes of SD cards, we haven‟t yet found one it 

won‟t work with.  

10.12 Is it easy to use? 

The DL1 PRO has one button to start and stop logging, how much simpler could we 

have made it? We have kept the software as simple as possible whilst making it as 

flexible as we can to ensure that you can do what you need to with it. As with all 

computer programs, the first time you use it there is a lot to take in - after you've 

become familiar with it, you will be able to analyse data quickly and efficiently.  

10.13 What specification of computer is required? 

As with most programs, the analysis software will run on just about any PC with 

windows 2000 or later – however, the faster the PC, the faster the program will run. The 

main restriction is the memory required for long runs; typically we recommend that 

your PC has an absolute minimum of about 30MB of memory installed for each hour of 

data loaded. The PC also requires some means of downloading the data from the SD 

cards, there are many options available – normally a USB reader is most convenient.  

10.14 Is the DL1 PRO reliable and well made? 

The DL1 PRO is absolutely class leading in terms or component quality, build quality 

and reliability – this is a very high quality professional instrument, entirely designed in-

house and manufactured in England. The unit carries the normal 12 month guarantee 

against manufacturing defects.  
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10.15 What options does my DL1 PRO have installed? 

To find this, open the DL1 PRO configuration software, connect to the DL1 PRO 

through the USB port in the usual way to read the configuration data, then go to Options 

/ Logger options. The list of available and enabled options will be displayed:  

 

 

 

10.16 Can I add extra options to my DL1 PRO? 

All options except for the Gyro can be added by a software update file. If you wish to 

purchase any options please see read the following section for the list of options and 

prices.  

http://www.race-technology.com/dl1_2_27.html 
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11 DL1 PRO Software 

11.1 The Analysis Software 

The analysis software is the main package that is supplied with all Race Technology 

products capable of logging data. The analysis package is used to load, view and 

analyse the data using a variety of tools. For more information on the Analysis software 

read the following section: 

http://www.race-technology.com/wiki/index.php/Software/MainAnalysisSoftware 

11.2 The Realtime Monitor 

The realtime monitor software is intended to view the serial output of our products in 

real time. The monitor software is particularly useful for checking that the hardware is 

installed correctly, and that all the signals are operating correctly. For information on 

the real-time Monitor software, read the following section: 

http://www.race-technology.com/wiki/index.php/Software/Monitor 

11.3  The Lite Monitor 

The Lite Monitor can be used to display live serial data from a number of RT products, 

including the DL1, AX22 and SPEEDBOX. More information on the Lite Monitor 

software can be found here: 

 http://www.race-technology.com/wiki/index.php/Software/LiteMonitor 

11.4 The Configuration Tool 

The configuration software is required to read or write the configuration on your DL1 

PRO, or to reflash it through the USB port. For information on the Configuration tool, 

read the following section: 

http://www.race-technology.com/wiki/index.php/Configuration/DL1MK3Configuration  

11.5 Re-Flashing Your Unit 

At Race Technology, we are constantly improving our products. This means that, from 

time to time, you may wish to re-flash your unit with the latest firmware. 

For information on re-flash your unit, read the following section: 

http://www.race-

technology.com/wiki/index.php/ReflashingDataLoggerDevices/ReflashingTheDL1MK3  


